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1 Introduction 

This manual is a reference book for working with large assembly in Inventor. You will learn the rec-
ommended techniques and workflows for managing and handling large assemblies in Autodesk In-
ventor. You’ll learn how to implement standard processes, tips and tricks, as well as some typical 
workflows and techniques in Autodesk Inventor 2014 to ensure your desired productivity levels are 
achieved… or even surpassed. 
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2 Hardware and System Configuration 

2.1 Recommendations 

For Inventor 2014 Windows users, we recommend you using below hardware and system to work 
with large assembly models, with such configurations, you will feel much smoother to run the large 
datasets.  

 64-bit Windows 7 or Windows 8  

 Dual Six core processor (12 cores total)  

 24 GB or more system RAM 

 DirectX 11 level graphics card with 2 GB or more video RAM (CAD workstation-class graphics 
card ) 

 Two (or more) 1-TB hard disk drives, SATA, SAS, Ultra 160 and Ultra 320 SCSI, SSD, RAID 0 
or 1, 7200 RPM or better.  

While, if you can’t reach above recommendations, please at least configure your system as below, 
this is the minimum requirement to run large datasets:  

 64-bit Windows 7 or Windows 8   

 Quad or Six core Intel Xeon processor  

 12 GB or more system RAM  

 DX 11 level graphics card with 2 GB or more video RAM  

 At least 1 TB of hard disk space 

 

2.2 Hardware and system detail information   

Next, we will talk these hardwares in detail. While you may want to know your system information 
first, here, we introduce you 3 ways:  

 RMB My Computer->click Properties, then view the basic information of the system, and you 
can click Device Manager to find more information there, eg. Click Display adapters to query 
the graphics cards and drivers information. 

 Query from system’s DirectX Diagnostic Tool, which can be launched from Windows Start, typ-
ing dxdiag in the Search box, and then pressing ENTER, system information and graphics 
cards information can be browsed from System and Display tabs of the tool.  

 Query from Inventor Diagnostics, launch Inventor, open a document, then go to Application 
Options->Tools->Hardware->Click Diagnostics and Ok button, then you can paste the Inventor 
Diagnostics information to a text or word file, and watch these system and graphics information 
there.  

 

Operating 
System  

As we know, running the large assemblies requires more memory, so we recom-
mend you use a 64-bit operating system because it doesn’t have any limit of RAM, 
while for 32-bit operating system, it is restricted to a maximum of 4 GB of RAM.  

Graphics 
Card 

This is an important hardware for Inventor such 3D application to run large as-
semblies. We recommend you use DirectX11 graphics card with more video RAM, 
because more and more Inventor features are now implemented based on Di-
rectX11 API.  
Meanwhile, we recommend you use workstation level graphics cards which own 
better performance compared to consumer level cards, such as NVIDIA Quadro 
family cards, AMD FirePro familiy cards, etc.  
Also you can refer to Autodesk certified graphics hardware page to search the 
recommened cards and drivers:  
http://usa.autodesk.com/adsk/servlet/cert?siteID=123112&id=16391880 
Please always keep your graphics drivers updated, you can use the one from Au-
todesk certified graphics hardwar page, also it is recommened to download the la-
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test one from vendor’s driver downloads center, such as for NVIDIA driver down-
loads, you can go to http://www.nvidia.com/Download/index.aspx?lang=en-us 
, while for AMD Graphics Drivers and Software, you can click this link to find more 
http://support.amd.com/us/gpudownload/Pages/index.aspx.  
If you are using laptop with mobile graphics card, you can get the graphics drivers 
from the laptop vendor drivers download center.  

RAM The more RAM you have installed in your machine, the better. Check the 
motherboard spec to see the maxium amount of RAM that can be installed. And 
use the fastest RAM available. The following table provides a general guideline for 
the recommended amount of RAM. Actual requirements vary depending on com-
plexity of part geometry and number of occurrences.  

Number of unique parts Recommended RAM in GB 

>5000 6 

>10,000 12 

>15,000 18 

>20,000 24 
 

Hard disk Hard drive read/write times affect the time required to open or save an assembly, 
while Solid-state drives can improve this performance, so if you have enough 
budget you can use such hard disk. If you don’t, please refer to the recommended 
hard disk.  
Inventor uses segment loading when accessing files, which means that only the 
required parts of the file are loaded in memory. The rest remains on the hard drive. 
Consequently, when additional segments from the file are required, it is beneficial 
if they can be read as fast as possible. You can follow our suggestions to improve 
the hard disk performance, please refer to the help topic “Hard disk drive configu-
ration” in wiki help http://wikihelp.autodesk.com/Inventor/enu/2014/Help/1283-
Inventor1283/2454-Assembli2454/3172-Large_As3172/3180-Inventor3180. 

Dual proces-
sors 

You can gain some benefit from using multiple processors in Inventor. However, a 
faster, single processor can be more desirable. By design, Inventor is not a multi 
threaded application. The processing load cannot ordinarily be balanced over mul-
tiple processors. However, some specific functionality in Inventor does support 
multi-core technology.   
The wisest choice is to procure the fastest single CPU that your budget allows. If 
your budget allows, buy the two fastest dual CPUs.  

Others  Such as network impact to Inventor performance, etc. You can get more informati-
on from wiki help “Inventor optimalization for large assemblies“ section.  
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3 Inventor Optimization 

Inventor have some settings which can be adjusted to improve performance, let’s take a look at which 
of them are benefical to you.  

3.1 Project Settings  

Project Files Inventor->Get 
Started->Projects 

Project files organize Inventor data, and determine the loca-
tion of the working data, templates, styles, and libraries. Be-
low are some suggestions for you:  

 Set the Included File path option to point to a single, 
read-only project file maintained on the network by 
the CAD administrator. 

 Workspace should never be on a network location. It is 
intended to be local on the users’ machine. All work 
should be performed on files held locally and when 
finished copied back to the network.  

 The fewer workgroup search paths defined, the better. 

 An excessive number of mapped network drives will 
slow down the machines ability to open and save 
files as Windows attempts to resolve these every 
time. 

 Keep relative paths = true. Relative in this instance 
means relative to the location of the project file. 

 Keep the Projects directory structure as flat as possi-
ble and Windows Explorer Directories structured as 
needed. Avoid folders containing more than 800 files. 
Top level assemblies should appear in a folder with 
the project file (*.ipj) and all the parts\subassemblies 
it contains should be located in a subfolder.  

 For portability, define all storage locations as subfold-
ers of a directory, which only contains the project 
definition file (e.g. project.ipj). 

For more information, please refer to Tools and Methodolo-
gies section of “Inventor optimization for large assemblies”. 

 

3.2 Application Options  

Item Access from Ap-
plication Options 

or Other Place 

Recom-
mendation 

Reason 

Show com-
mand prompt-
ing 

 General  Off  When this setting is enabled, it will take addi-
tional time to display the command prompts 
in a tooltip near the cursor.  

Enable Opti-
mized Selec-
tion  

General  On It can improve graphics performance while 
pre-highlighting in a large assembly. When 
selected, the Select Other algorithm initially 
ranks only the objects closest to the screen. If 
you click through this first group of objects, it 
ranks the next group. 

Undo File Size 
(MB) 

General >=1000MB This setting is to set the size of the temporary 
file that tracks changes to a model or drawing 
so that you can undo actions. For large or 



Large Assembly Performace  

 

Inventor Optimization Page 7 of 41 
 

complex models and drawings, increase the 
size of this file to provide adequate Undo ca-
pacity. Enter the size, in megabytes, or click 
the up or down arrow to select the size.  

File Open Op-
tions-
>Assembly-> 
Design View 
Rep 

File Last Active 

& 

Associative 

Opens the File Open Options dialog box. Set 
the representation that is loaded by default, 
unless specified by the Options command 
from the Open dialog box.  

In Assembly tab, suggest setting Last Active 
for Design View Rep, and selecting the 
checkbox of Associative. 

Defer update Assembly On This setting is to set preference for updating 
assemblies when you edit components. Se-
lect the box to defer updates of an assembly 
until you click Update for the assembly file. 
Clear the check box to update an assembly 
automatically after you edit a component. 

In large assembly, the setting is always se-
lected, and you could update the whole as-
sembly when needed manually 

Enable Pre-
highlight 

 Colors Off It shows prehighlighting when the cursor mo-
ves over an object. Activated by default. And 
it takes additional memory to have such opti-
on on.  

Display Quality Display Rough After changing to Rough setting, the display 
quality of the datasets is not as good as befo-
re, but the performance will improved a little.  

Textures On Display->Settings Off If the model has used several appearances or 
materials with textures, you could turn off this 
setting to increase the view interactive per-
formance. And the model will show without 
textures.  

You can also unselect the Textures On check 
box from View tab of Ribbon UI to avoid the 
change to other models with the setting from 
Application Options.   

View transition 
time 

Display 0  This setting controls the time required to tran-
sition smoothly between views when using 
viewing commands (such as Isometric View, 
Zoom All, Zoom Area, View Face, and so on). 
Zero transition time causes transition to be 
abrupt, which can make it difficult to under-
stand changes in position and orientation. But 
will make you feel better performance for 
viewing commands.  

Minimum frame 
rate (Hz) 

Display 10 With complex models (such as large assem-
blies with a high component count), specify 
how fast to update the display during interac-
tive viewing operations (like Rotate, Pan, and 
Zoom). To maintain a high frame rate, the 
system sometimes simplifies or discards 
parts of the view. The view restores when 
movement ends.  
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 Set 0 Draw everything in the view, re-
gardless of the time required. 

 Set 10 Draw at least ten frames per 
second. 

 Set 20 Draw at least twenty frames per 
second.  

Tips: Increase the frame rate if the model 
updates too slowly during a viewing opera-
tion.  

Performance Hardware On This is Inventor’s default setting, it favors sys-
tem performance over graphics quality. it 
turns off Anti-aliasing for machines running 
Windows 7 and 8.  

Retrieve all 
model dimen-
sions on view 
placement 

Drawing Off Be default it is on, it will take more time and 
memory to get the dimensions during view 
placement, so you can clear it if you don’t 
want these dimensions but expect better per-
formance during view creation.   

Display line 
weights 

Drawing Off This setting enables the display of unique line 
weights in drawings with more memory con-
sumption. If clear the checkbox, it will show 
lines without weight differences but a little 
better performance.  

Show preview 
as  

Drawing Bounding 
Box 

This sets preference for preview images. The 
default is All Components. Click the arrow to 
select Partial or Bounding Box. While Bound-
ing Box option takes the least memory con-
sumption. The preview has no effect on the 
resulting drawing view.  

Section View 
Placement as 
Uncut 

Drawing On This setting controls section preview with or 
without cutting components, and with cutting 
components takes more time and memory to 
compute the preview. So recommend use 
uncut. The preview has no effect on the re-
sulting drawing view.  

Enable back-
ground updates 

Drawing On This setting allows you to switch the display 
of raster drawing views on or off.  
Raster views increase your productivity when 
you work with drawings created for large as-
semblies. You can review a drawing or create 
drawing annotations before precise calcula-
tion of drawing views finishes. Precise draw-
ing views are calculated in the background 
while you work with raster views.  

Use Bitmap Tools->Document 
Settings->Drawing-
>Shaded Views 

Always  This setting is only valid for Shaded drawing 
views, set it to Always, it will use bitmap to 
generate the shades, which gives better per-
formance compared to Offline only which 
needs compute the shade time by time during 
viewing commands.  
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Tips: To be convient, we recommend you export 
these Application Options settings into an xml fi-
le, and save it in local, next time, you can directly 
import this xml file into Inventor to have the 
customized Application Options instead specify 
one by one. This can be done by the Export and 
Import button under Application Options dialog.  

 

 

3.3 Others 

3.3.1 Unload unneccessary add-in to speed Inventor 

Use the Add-In Manager to specify which add-ins to load at startup. You can also unload certain add-ins 
while in session. The available add-ins and their load behavior is listed in the dialog box. Add-ins not 
loaded at startup is listed without a load behavior. When an add-in is unloaded, its functionality is not 
available. However, all translator add-ins (such as DXF, DWF, and DWG) automatically load when that 
format is selected when doing a Save Copy As. By default, the translators are not loaded at startup. You 
cannot unload or load an Autodesk Inventor Professional add-in in session. Restart the application for your 
selection to take effect. 



Large Assembly Performance  

 

Inventor Optimization Page 10 of 41 
 

 
 
You may want to consider unloading to: 

1. Reduce the time it takes Autodesk Inventor or Autodesk Inventor Professional to load initially. 

2. Reduce the memory footprint for the application and increase the capacity. An increased capacity 

enables you to work with larger assemblies. If you experience capacity issues while using Autodesk 

Inventor Professional, unload some of the larger add-ins (such as Tube & Pipe, Cable & Harness) if 

they are not used in your design. In most cases, it is recommended that you do not unload Autodesk 

add-ins. 

3. Correct problems with the application. If you experience problems with Autodesk Inventor, start to un-

load non-Autodesk add-ins systematically to see if unloading corrects the problems. It is possible for 

some non-Autodesk Inventor add-ins to be invalid for a current release, and unloading them may 

correct problems. 

 

3.3.2 Organize Design Files in a Folder Structure 

Avoid storing all assembly files in one folder. When Autodesk Inventor must search through hundreds or 
thousands of files in a single folder to find the correct file, it can take longer to open files. As part of the file 
name, Autodesk Inventor stores the path to the folder where a file is located. When there are fewer files in 
a folder, the file is located and opened more quickly. 
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3.3.3 Plan for Assembly Hierarchy Efficiency 

Plan the top-level assembly and subassembly structure before you create parts. Create logical subas-
semblies and combine them into larger assemblies. Keep all components used in a subassembly in the 
same directory. Create a shared network directory for components that will be shared by many designers 
on many projects. Assign the Summary and Project properties for individual components. Create a unique 
template and use it to create components for a specific project or subassembly. Predefine common proper-
ties in the template so all components created from that template inherit the properties. Search for attribu-
tes both inside and outside Autodesk Inventor to find needed component files. Save and name attribute se-
arches that you are likely to use again. 

 

3.3.4 Create custom Content Center Library 

Inventor Content Center database contains over 750,000 parts and covers 18 international standards.  
Considering your design requirement, only load neccessary library will boost your speed to load Content 
Center and  place from it. 
 
If you only use small portion of content of the library, you can also consider to copy your required families to 
the custom library, then only load it in your project setting. 

             
 

3.3.5 Defer update 

By default, assemblies automatically update when changes are made. As assemblies become larger, this 
update requires more computational time. If it is not important to monitor updates simulataneously, it is 
recommended that you defer automatica updates to speed up the edits. you can select the checkbox to de-
fer update from assembly tabe in application setting. 
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 If there is any update, the yellow update flashlight icon is on. You can update it later in idle time by task 
scheduler or to click the icon. 
 
For tube and pipe, cable and harness, they are more expensive in computer memory, and you can select 
the checkbox to defer update in respective setting dialog by RMB click on the top node.  

   
 

          
 
Not like generic assembly, Deferred items of T&P and C&H are indicated with the Update Deferred icon 

in the browser. If items in a harness part have updates deferred, the items are not shown in the graphics 
window.  Noticed These items will not be updated until you uncheck the defer setting. 
 
A word of  caution: use this approach only as a last option, as one can forget to reset it to the normal ‘un-
checked’ condition. 
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4 Large Assembly Methodology 

4.1 Simplification Workflow 

Simplification is a key point to reduce the number and complexity of parts in large assemblies. Especially 
purchased components and company standard components should be modeled as simple as possible 
and as detailed as necessary. Because these types of components are normally reused often but there 
is no need to edit them – so keep them simple! 
This simplification work pays off every time you insert such a component. Before you start simplifying 
components we recommend making a copy and using this copy to generate the simplified part. 

 

Simplification Workflow--Overview

S
im

p
lif

ic
a

ti
o

n

P
h

a
s
e

Phase 1

Reduce number of 

components

Purchased

Components

Phase 2b

Reduce complexity 

of components

Phase 2a

Reduce complexity 

of part

No

Yes

 

4.1.1 Phase 1 – Reduce number of components 

1) In these steps, we mainly consider selec-
tion tools to reduce the number of com-
ponents. Open assembly “ 57581.iam ” 

2) Activate or create Level Of Detail (LOD) 
“Simplified” 

 

 
 



Large Assembly Performance  

 

Large Assembly Methodology Page 14 of 41 
 

3) Reduce number of components: 

 

Now select all the parts that you don’t 
need to show in the simplified represen-
tation and suppress them. 

Especially fasteners and hidden details. 

 

It’s very helpful, to use the Component 
selection tools to do that. 

e.g. Internal components, Components 
smaller than … 

 

This step reduces the number of com-
ponents, that show up in the derived 
component dialog later. 

 
 

 
 

 
 

 
 

4.1.2 Phase 2a – Reduce complexity for part 

The only difference is that  there is a phase 2a to handle manufactured part or purchased components. 
Since we don’t need  the detail of these components, we can ignore these part features that have no 
effects on others, and only care its boundary, so we can suppress these unnecessary features and re-
duce complexity. There are two cases for introduction – 

4.1.2.1 Manually suppressing unneccessary features 

1) Launch Autodesk Inventor 2014 if it is not al-
ready open.  

2) Ensure that the project is set to “19525100” by 
clicking on the “Project” icon in the Ribbon.  

3) Click “Done” if needed.  

4) Click “Open” and browse for “19525100.iam” 
then click “Open”.  
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5) In the modeling area, hold “Shift” and right 
mouse click to bring up the “Selection Filters” and 
change from “Component Priority” to “Part Priori-
ty”  

 
6) Rotate the model so you are looking at the bot-
tom side. Use both “Shift” and middle mouse 
wheel to rotate or select “Bottom” on the view cu-
be.  

7) At the tail end of the conveyor is a pulley guard 
(see image below). On the bottom of the pulley 
guard is grated steel (part 57569.ipt). Open this 
part in a new window.  

 
(HINT) You can use the “Find” icon and search for 
the specific things in an assembly. They will be 
highlighted in the model tree and the graphics 
window. This can save time when dealing with 
large assemblies. The user modeled this with two 
features and a pattern. Even though the pattern 
might reflect how the part will look, this creates 
more work for Inventor. To put a value to this, the 
part as is requires 786KB of disk space. With so-
me modification to the part you will bring this file 
size down to 105KB.  
The intent is to keep the flat pattern. Select the 
features shown below in the red box and delete 
them. 
This will reduce the file size to 96KB. At this point, 
the file is now a solid. For accurate information, 
especially center of gravity, this is not acceptable. 
What you need to do is change the physical pro-
perties of the part to visually look the same, and 
accurately reflect the weight. You will need to co-
me up with a density that will be used to calculate 
a true weight. Here is how I did it.  

 

From the original part iProperties I found the 
weight to be 16.95 lbmass and the volume to be 
59.68 in^3. After deleting the features the volume 
is now 352.58 in^3. Since I want the weight to 
remain the same, take the old weight and divide it 
by the new volume to get a corrected value to use 
as the density.  

 
Now you need to modify the style of the part to re-
flect the corrected density and visually look the 
same.  
(HINT) You could use the “Find” icon and search 
for the specific values in an assembly like part 
number, description etc. After searching, they will 
be highlighted in the model tree and the graphics 
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window. This can save time when dealing with 
large assemblies. 

8) In the Ribbon, select the “Material” under the 
“Tools” tab.  
Since a form of Steel is assigned to the part, you 
can use this as the base. Right-click “Steel” to 
duplicate new material. 
Name this new material “Grated Steel”. 
Assign the new material “Grated Steel” to the part. 

 

9) Now you will need to change the part to look li-
ke the grated steel. Edit the material “Grated 
Steel”, change to appearance tab, add the image 
below to Generic section.  

 

 
10) Now you should be looking at the assembly 
and the Grated Steel should be visually and phy-
sically acceptable. An alternative method is to just 
override the weight. 

 
(HINT) Now that you have gone through the trou-
ble of changing the part, you could use this as a 
Template for creating grated steel models in the 
future. Create a folder in your Templates Directory 
named “Grated Steel” and add a copy of this part 
to the folder. When you hit the “New Document” 
icon you will now see a folder with your grated 
steel template. If your templates are in a network 
location then everyone in the company will be ab-
le to use this.  
(HINT) Now that the new part is solid, this means 
that drawing views will not show the objects be-
hind the plate in non-hidden line views. Use Break 
Out to view files that are hidden behind solid ob-
jects. 
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4.1.2.2 BIM simplification for the 3rd party part  

1) Open part TEFC NEMA, 215T.ipt, which is a 
purchased component with ~9M file size. 

 
2) Go to BIM environment, and use Remove De-
tails, Fill Voids and Define Envelopes comands to 
simplify complexity. 

 
3) Export it to SAT file, and import it to Inventor, 
then save it, and the filesize is ~1.3M 

 

4.1.3 Phase 2b – Reduce complexity of components using VR and LOD 

For large assembly, at the upper level, there are some components that are not so important or so small 
that can be neglect on a print.  
 
View Representation and Level of Detail are two main tools to be used to reduce number of compo-
nents. 
 
When considering LOD and VR for simplification, the LOD like “Simplify” could be defined in assembly 
template. 

 
 View Representation 
View Representations (View Reps), formerly known as Design Views, are a good place to start control-
ling the view of the displayed objects.  View Representations improve performance by reducing the load 
on the Graphical Processing Unit (GPU) while data is held in memory. 
 

 Level of Detail (LOD) 
The LOD’s an assembly tool to organize simplification levels. The information if a component is sup-
pressed (unloaded) or unsuppressed (loaded) is stored in the LOD’s. Comparing to View Reps, sup-
pressed component will be unloaded, it will reduce memory consumption in the assembly and drawings, 
and improve performance much better than View Reps. 
It’s quite easy to copy View Reps to LOD and vice versa. 
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In below case, we will use a sample data to demostrate the recommended workflow. First we load the 
assembly 19525100.iam. 

 
 

 

4.1.3.1 View Representation 

1) Change the selection filter back to “Compo-
nent Priority” by holding “Shift” and right cli-
cking in a blank space in the model window.  

2) Select “Right” on the view cube.  

3) To create a View Representation, right click 
on View and select “New”.  

4) Name the new view “Tail Section – Purcha-
sed Components”. To change the name, per-
form two slow clicks on the new View.  

5) Left click and hold in the upper left area 
above the conveyor.  

6) While holding the left mouse button, drag to 
the lower right stopping just past the 7/8” 
bolts that connect the two lattice sections to-
gether.  

7) Once the selection is made, right click and 
select “Isolate”. Hit “Save” and save all if 
prompted.  

8) Now select the guards (in yellow) and the 
hopper (in grey) and turn the visibility of tho-
se off. Don’t forget the Black flap on the top.  

9) Now select the support leg and pins. Turn the 
visibility off also.  

10) Create a folder to place all those purchased 
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components, here we create a folder named 
“Hardware” 

11) Save the assembly and keep open.  
12) Right click on the “Hardware” folder and turn 

the visibility of all hardware off.  

 
13) Once the information shown on the screen is 

correct, hit the F6 key, right click on View 
Representation “Tail Section – Purchased 
Components” and select “Lock”. This will 
keep new additions to the assembly from 
showing up in this View Representation.  

 
14) Save the assembly and keep open.  
 
 
Tips:  It is very convenient to create Represen-
tation when components are grouped with fol-
ders.  

 (HINT) To put components into a folder, 
either select them in the model tree and 
choose “Add to new folder” from the right 
click options or right click in a white spot 
on the model tree and choose “Create 
new folder” then drag and drop compo-
nents into this new folder.  

 (NOTE) Creating component patterns 
with items in a folder will remove them 
from the folder.  

 (NOTE) You will not be able to take ad-
vantage of “Alpha Sort” once you create a 
folder.  

 

 
 

      
 

 

4.1.3.2 Level of Detail 

1) Make sure the View Representation is set to 
Default or Master.  

2) Right click on “Level of Detail:Master” and 
choose “New Level of Detail”  

3) Name the new LOD “Large Assembly” and 
save the model.  

4) At the tail end of the conveyor, right click on 
the hopper and select “Open”  

5) Switch to the “View” tab above the Ribbon, 
select “Object Visibility” and remove the 
check next to “All Work features”.  

 
Tips: (HINT) Work features take up resources. I 
find them to be very important when designing 
and constraining but are not needed when the 
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model is complete. If you do not need to have 
them visible, turn them off to save system re-
sources.  
 
(HINT) When dealing with large assemblies it is 
important to remove components from memory 
that are not necessary in the overall layout. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
6) Now that 57584.iam is open in a new window, 

right click on “Level of Detail:Master” and 
choose “New Level of Detail” and name it 
“Large Assembly”. To change the name, per-
form two slow clicks on the new LOD.  

 
7) Suppress all components that are not im-

portant at the upper level when modeling. 
Usually, we try to keep enough of the outside 
so it is recognized on a print and leave criti-
cal parts that defin an inlet, discharge or 
mounting points. Here, all items marked can 
be suppressed. 

 
Tips: Selection Tool  
(HINT) Using the selection filters is a good way 
to select multiple parts that are the same, not 
near each other and do not belong in a compo-
nent pattern. In the window, hold “Shift” and right 
click and choose “Select All Occurrences”. 
 
8) Save and close the sub assembly to return to 

main assembly. 
9) Now let’s look at the tail end again. Right click 

on the tail section lattice frame (57581.iam) 
and open in a new window.  

10) Create a new LOD called “Large Assembly”. 
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Feel free to suppress components in the as-
sembly that you believe will have little effect 
on the way the upper level assembly will look 
on a drawing. I will have some suggestions 
shown below.  

11) Use your selection filter and set to “Part Prio-
rity”.  

 
Tips: 
The goal here is to keep enough information for 
you to work at connection points, inlet and 
discharge areas. Most important though, you 
want this to look good on a drawing or be able to 
display your intent of the design with as few 
lines as possible. Just like parts consume re-
sources and effect performance, lines on dra-
wings do the same thing. 

 
12) In this case, we removed gussets, the two 

side plates and the cross angles on one side 
and the bottom. This will still give the dra-
wing the same appearance and reduce the 
amount of detail the system needs to mana-
ge.  

13) Save and close to return to the main as-
sembly.  

14) If you switched to Part Priority, switch back 
to Component Priority.  

15) With the main assembly open, hold control 
then select the hopper and lattice frame that 
you created the Large Assembly LOD.  

16) Right click and select the “Level of Detail 
Representation” dropdown. In there you will 
find both of the LOD’s created for the two 
sub-assemblies. Select “Large Assembly” 
and hit OK and then save the model.  

 

 (Hint)it is more efficient to create Representa-
tions right before taking a large assembly to 
the drawing stage. Last minute changes to 
the design can cost you time to go through 
the assemblies and update the LOD’s. 

 

 Tips: If there are many sub assemblies have 
defined LOD with same name (i.e, Large As-
sembly in this case). An alternative solution 
is to Link Level of details from productivity 
tool in Assemble Tab. 
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In Level of Detail Representation, beside the way to suppress unneed components and define a re-
presentation to manage it, another way is substittute. Substitute LOD’s provide a comprehensive set of 
tools to create a lightweight or simplified part. Use them to protect intellectual property, significantly re-
duce memory consumption on upstream assemblies, or to exchange a part file “assembly skin” with 
others. 
All substitute representations preserve the original mass properties and parts list. 
 
Now we will create LOD’s using the Substitute “Derive Assembly” and “Shrinkwrap”. The example you 
will work on will expose you to their differences. Both methods have their place but it is up to you to de-
cide which method works the best on what information is needed for the shop to fabricate and assemble 
your designs. 
 

4.1.3.3 Create Level of Detail—Derive Assembly 

 
1) Continue to use assembly 19525100.iam.  

2) First you will look at the “Derive Assembly” 
Substitute. A derived part is a new single part 
with a reference to an assembly or part. This 
method will copy bodies, sketches, work fea-
tures and parameters. By default they will be 
associative.  

3) Open the Tail End Lattice Section (57581.iam). 
Open the Take-Up body (12 INCH HD-
TU.iam).  

4) The dialog gives you the option to change the 
file name, choose a template and where to sa-
ve the file. For this, hit the dropdown for 
Templates and choose “Standard-no 
sketch.ipt” and hit OK.  

5) The next dialog will control the amount of detail 
you want to show in the model. Make your 
window look like mine. My preference of Deri-
ve style is to choose the second option for 
“Solid body keep seems between planar 
faces”. This gives a better representation of 
the model and will not merge faces together 
but will not give the best performance since 
more lines are being drawn on the model. This 
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option also provides better control on what you 
constrain to the faces and displays better in 
the drawing. Once you have highlighted the 
parts below, choose the Red button to not ha-
ve them show up in the derived part.  

 

(HINT) using the “Single composite feature” will 
produce a derived part with the smallest file size. 

 
6) Select “Other” tab to remove iMates, sketches, 

parameters and work features. Click the Circle 
next to the assembly and change the status to 
“Exclude the Selected Objects” for all compo-
nents.  

7) The Representation tab will allow you to derive 
the assembly based on an existing Design 
View, Positional or Level of Detail Representa-
tion.  

8) get into the Options tab later. For now hit OK 
with the default settings.  

9) Save and close the Take-Up assembly.  

10) Select both Take-Up assemblies right click 
then choose “Representation”.  

11) Select the Substitute LOD you just created 
then hit OK, save the model and close the tail 
end lattice section returning to the main as-
sembly.  

12) The coolest part of this is that LOD’s can be 
used at any level in the assembly structure 
and carry to the upper level assemblies to 
simplify the model and reduce the demand on 
the system. This is where I have seen people 
(including myself) believe that a derived sub-
stitute without removing parts or features is 
better. Creating a derived assembly will be 
better on visual performance (i.e. 
pan\zoom\rotate) but will create a file that re-
quires the same amount of RAM to have open. 
For systems with RAM limitations this will be 
something to pay attention to. The key is to 
remove features, especially curved features as 
these tend to demand more from Inventor’s 
shape modeler. Using the Derive Assembly 
gives you the most flexibility on managing your 
data. 

 
(HINT) Use this method to create simplified mo-
dels for FEA and Dynamic Simulation. 
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4.1.3.4 Create Level of Detail – Shrinkwrap 

In the next example I will have you create a 
Shrinkwrap version of the middle lattice section. 
Shrinkwrap will strip the model of more informati-
on than Derive Assembly will. This does a great 
job of simplifying the model with little input. 

 
1) Open the middle lattice section “19525700.iam” 

in a new window.  

2) Right click on “Level of Detail:Master”, “New 
Substitute” and choose “Shrinkwrap”.  

3) Change the Template to “Standard-no sketch” 
and leave the default setting for the rest and 
hit OK.  

 
Now we have the Shrinkwrap options window. 
This is the same as the Derived Assembly, “Opti-
ons” tab except that you can choose the “Style” of 
part to create. Using the default settings will pro-
duce the best performance results while visually 
showing enough to show the design intent.  

4) Remove the check mark next to “Work Geo-
metry” under the “Include other objects” sec-
tion.  

5) Use the “Preview” button to see what the part 
will look like before committing.  

 
(HINT) If you wanted to take this deeper you can 
remove parts by a size ratio and work features to 
improve system performance. The size ratio is an 
approximation for selecting parts in an assembly 
to remove. To calculate the size ratio for removing 
components that you decide are note needed, 
take the longest measurement found on the geo-
metry extents and divide it by the longest measu-
rement of the part you want to remove from the 
model. Bumping this up 2-3% will ensure you re-
move the parts you want while maintaining the 
design intent. 
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As to shrinkwrap, Inventor also provides another three methods to create it. 

1) From Ribbon Command 
In the Ribbon, Assemble tab, under component is 
an expandable icon called “Shrinkwrap”. Selecting 
Shrinkwrap from the drop down will produce a 
simplified version of the assembly in a new 
window. Use the Shrinkwrap icon from the 
dropdown to create simplified files that you will 
send to customers. Using Shrinkwrap Substitute 
produces a new assembly LOD.  
 
(NOTE) If the active assembly state is an LOD, 
then using these options will create Shrinkwrap 
versions of the active assembly LOD. This is a 
great way to take advantage of an already simpli-
fied assembly and minimize the part count in the 
open document. 

 
2) From Command in Productivity tab 
Another choice is to select “Create Substitutes” 
under the “Productivity” tab. This will create Sub-
stitutes for all sub-assemblies. Let’s try this one.  

 

Change the Level of Detail to “Master”. If the as-
sembly is in a LOD state where two assemblies 
with the same file name are set to different Re-
presentations, the program can’t perform two edits 
on a single document.  

 
expand the Productivity panel and choose “Create 
Substitutes”  
 
(NOTE) Make sure to hit “Apply” when changing 
the “Naming Scheme”. If you forget to do this In-
ventor will create Substitute file names the way it 
is displayed in the “Substitute Part Name” column. 
This will create a lot of work to remove what was 
done once created. 

 
You can change the file save location by high-
lighting several rows, right clicking on “Source 
Path” and choose “User Path”. This will allow you 
to change the location of the Substitute.  

 
If you are not satisfied with the default results from 
the automated process, the Substitutes can modi-
fied.  

 

Click the OK button and accept the message 
about creating the Substitutes and read thru the 
Task Scheduler information below while Inventor 
creates the substitutes  
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3) Through Task Scheduler 
Task Scheduler is another resource available for 
you to create simplified models. This tool is exten-
sive and is designed to run tasks using all of your 
system resources. It is important to understand 
the output from running tasks so perform testing 
with files that are not going to be used for produc-
tion.  
 
Task Scheduler was designed to perform tasks 
with minimal input from the user to automate more 
of your time consuming duties like creating Substi-
tutes of very large assemblies. You might need to 
make some adjustments to the output if the re-
sults do not match your company standards. Edi-
ting the Derived component is done the same way 
as described above.  
 
The benefit to using Task Scheduler is that multip-
le cores can be leveraged. In other words, each 
task you define can be performed simultaneously 
with other tasks. Sequential tasks are treated as 
one task, grouped together, so only one core is 
dedicated to processing it. You can use Inventor 
and Task Scheduler at the same time. 

 
1) Open Task Scheduler from Start\All Pro-

grams\Autodesk\Autodesk Inventor 
2012\Tools\Task Scheduler.  

2) Once Task Scheduler is opened, click on the 
“Settings” button at the top and select “Multiple 
Processes”  
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I like to leave 2 processes free and keep the 
“Abort” option checked. Running multiple proces-
ses of Inventor can consume all available RAM. 
Once that happens Inventor will start paging. On-
ce paging happens, your efficiency is significantly 
reduced.  

 
3) Select “Create Task” then “Shrinkwrap As-

semblies”  

 
The Project path should point to the data you are 
working on. If it does not, browse for the 
19525100.ipj file.  

 

4) Now you need to tell the program what data to 
perform the task on. Hit the first icon to “Add 
Files”.  

 
You should be looking at your data.  

5) Select a group of assemblies. Try 5-6 of the 
first assemblies.  

6) If you want to run the task now, check the box 
next to “Immediately” and click the options but-
ton.  

 
(HINT) Sometimes it is better to create the indivi-
dual tasks all at once without running immediately. 
This gives you some flexibility to change to tasks.  
TIPS:  
Set a time after you leave for the day to perform 
these tasks. If your data is on a network, the re-
duced traffic will allow your tasks to run faster so 
you can be more efficient. 

 
Select the options that you want for the Substitu-
tes and hit OK to exit the options and OK again to 
start the task.  
The Shrinkwrap substitutes are added to a new 
LOD for each assembly in the main assembly. 
They will not be created for sub-assemblies of 
sub-assemblies of the main assembly.  
(HINT) While this task is running you can create 
other tasks by going back to step 6 above and se-
lecting a different group of assemblies. 

 
By now Inventor should be done creating the 
Substitutes.  
7) Update and Save the model.  
8) Keep this assembly open and in the new LOD 

you just created.  
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4.1.3.5 Create Level of Detail –Select Part File 

From RMB Context menu of Level of detail, there is 
the third way to create substitute, that is, select 
Part file.   

 

With this option we can add in a dummy part to be 
a place holder for a much more complex part. You 
can just make a cylinder or box to hold the location 
while you work around it.  
 
Considering previous case to simplify the motor 
with detailed features, we can select the simplfied 
part file to represent the complex one. 

 

 

4.2 Large Assembly Express Mode 

4.2.1 Open and review large assembly in Express Mode 

In Inventor 2014, we introduce new technology to reduce the time for opening a large assembly. In this 
case, user can open and review the assembly in short time. 
In order to implement this, we should firstly, migrate the dataset into Inventor 2014 version or save the 
dataset into Inventor 2014 version with necessary settings and then make sure the settings are as ex-
pected. After all the preparation, the large assembly will be open faster since only necessary compo-
nents will be loaded instead of loading all components as previous release. 

4.2.1.1 Migrate Dataset to Inventor 2014 

1) Launch Inventor 2014 Task Scheduler 
from “Start”-> 
”All Programs”->”Autodesk”->”Inventor 
2014”->”Tools”-> 
”Task Scheduler” 

2）In the Task Scheduler, invoke “Migrate 

Files” dialog from the Tab “Create Task”-
>”Migrate Files…”. 

3）Add the folder of dataset wants to be 

migrated in the Migrate Files 

 
 

4）Click the “Options…” button in the “Mi-

grate Files” dialog, and make sure the 
checkbox “Include Assembly Graphics For 
Express Mode” is  
Checked in the “Migration Options” dialog. 
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5 ） Combine other options you want to 

check as usual. Click OK button to close 
“Migration Options” dialog. And click OK 
button in “Migrate Files” dialog to start the 
task.  
Warning:  

1. Make sure to back up your dataset be-
fore migrating if you need to open 
the dataset in lower Inventor version 
in future. Because migrated dataset 
will NOT be open in previous Inven-
tor version! 

The size of the assembly will enlarge after 
migration. This is as expected. 

 

Tips : How to remove saved cache 
graphics: 
 
Solution1:  
Migrate the dataset with Task Scheduler. 
And make sure the checkbox “Include As-
sembly Graphics For Express Mode” is Un-
checked in the “Migration Options” dialog. 

 
Solution2: 
Launch Inventor 2014 and invoke “Applica-
tion Options” dialog from  
Ribbon “Tools”->”Options”->”Application Op-
tions”. Make sure the checkbox under “As-
sembly” tab for “Enable Express mode 
workflows (saves graphics in assemblies” is 
unchecked. 
Open the assembly in Inventor and resave 
it. 

 

 

4.2.1.2 Necessary settings 

1) Launch Inventor 2014 and invoke “Appli-
cation Options” dialog from  
Ribbon “Tools”->”Options”->”Application Op-
tions”. 
 

 

2) Make sure the checkbox under “Assem-
bly” tab for “Enable Express mode work-
flows (saves graphics in assemblies” is 
checked. 
You can also check Radio “Open Express 
when referenced unique files exceeds” and 
choose the number when unique files ex-
ceeds that number, the assembly will be 
opened in Express Mode by default. 
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Notice:  
Please make sure the Graphics Settings is 
NOT using “Compatibility”,  
Otherwise, the assembly will be open in Full 
mode no matter if it has been migrated or 
the Express Mode Settings correctly. 
 

 

4.2.1.3 Open the Large Assembly 

  There’re two ways to make sure the assembly is open in Express Mode instead of Full Mode: 

1) If you know the referenced unique files 
number in the assembly, you can set the 
“Open Express when referenced unique 
files exceeds” less than the number and 
open the assembly directly.  

2) If you have no idea about the referenced 
unique files number in the assembly, 
when open the assembly, you still have 
chance to choose open the assembly in 
Express mode: 

2.1)  Invoke Open dialog and select the 
assembly you are going to open. Do not 
open it directly but click “Options…” but-
ton to invoke the “File Open Options” dia-
log. 
2.2) Check the checkbox “Open Express” 
in the “File Open Options” dialog. 

 

 

4.2.1.4 Limitation 

1. Currently only referenced unique files number is huge, the open time will be reduced significa-
ntly but for an assembly with lots of patterned components, the improvement for opening is 
very limited. 

2. Only the Last Active Design View and Master Positional and LOD Representation will be open if 
you want to open the large assembly in Express Mode.  

3. Section View is not supported in Express mode. 
4. Realistic and Monochrome visual styles don’t work in Express Mode. 

4.2.2 Place Large Assembly in Express mode 

We always encounter the issue that placing component costs a lot of time especially when the placed 
component is a large assembly. This issue will make the user upset if they are using Bottom-Update de-
sign style. 
In Inventor 2014, we start supporting to place assembly in Express mode which means not all compo-
nents of placed assembly will be loaded but only the necessary ones. 
In order to implement this, the placed assembly and top assembly should also be migrated to Inventor 
2014 version with specific settings. Refer to the section “Migrate Dataset” in opening LA in Express 
Mode for detailed information. 
After the preparation, open the top assembly in Express mode and place the large assembly. In the 
“Place Component” dialog, click “Options…” button and Invoke the “File Open Options” dialog similar 
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with Open Large Assembly, and make sure “Open Express” checkbox is checked. Then you can place 
the component in short time. 
 
Note: This implementation is only workable with Inventor 2014 SP1 and higher service packs.  
 

 As to place component command, there are some tips for your reference: 

 As we know, the first component placed in a top assembly will be placed at the Origin of the top 
assembly. From R2014, there is an option in Application option to control the placement behavior 
of first component: 

           Application Options->Assembly tab->Place and ground first component at origin. 
 

If the checkbox “Place and ground first component at origin” isn’t checked, we could decide  whe-
ther the component is placed at Origin or other place. If it’s checked, the first component will be 
still placed in Origin position. 

 
 

 
 There has been some complains that only the first component could be placed at Origin, and user 

also want to place non-first components at Origin.  
In such condition, before R2014, user has to use the “Place at Component Origin“ command from 
Assemble tab->Productivity panel to place the following components at the Origin of the first com-
ponent. 

           
 

  From R2014, when place component, we could rotate the orientation of the component during 
placemnt. The rotation is along the rotate axis in the graphic window by following right hand rule. 

And we could rotate the component then place it at Origin, the Orientation will be kept during 
placement. See the detail information below. Here is an example for rotate X 90 degress then 

place grounded at Origin. 
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Workflows iProperties->Occurrence 
Rotate X 90 + Place grounded at Origin 

 
 

4.3 Matrix from Derive assembly, Shinkwrap and Express mode  

Functionality Case 
Derive Assembly  Create lightweight structure 

 The derived part can be scaled larger or smaller 
than the original or mirrored using any of the ori-
gin work planes of the base assembly. The loca-
tion and orientation of the derived geometry is 
the same as the base. 

 By selecting different combinations of parts and 
subassemblies, multiple derived parts can be 
created from a single assembly.  

 The derived part can contain components as mul-
tiple solid bodies.  

 The derived part can be used as a Substitute Le-
vel of Detail in the assembly it was derived from. 
This reduces memory consumption in upper-
level assemblies. 

 Weld beads could be selected as a solid. 

Shrinkwrap  Keep mass of the original assembly,  

 hidden some important details 

 Patch some holes which doesn’t relate with 
downstream workflow 

 The Shrinkwraped part can be used as a Substi-
tute Level of Detail in the assembly it was deri-
ved from. This reduces memory consumption in 
upper-level assemblies. 

Express mode  Reduce the time for openning large assembly. 

 Improve the performance of reviewing large as-
sembly like zoom in/out, pan and rotate. 

 Express mode can make placing large assembly 
in short time. 

 

4.4 Drawing  

4.4.1 Level of details & view representation for drawing 

Now let’s look at using LOD’s and view representation in a drawing. LOD’s are more valuable if you are 
having large assembly performance limitations. 
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1) When creating drawing views of large 
assemblies change the setting in the appli-
cation options\drawing tab to show the pre-
view as a bounding box.  

2) You should still have the assembly open 
and in the LOD state you just created.  
(HINT) When I create drawing views I will 
create the “Base View” first and then create 
the projected views only when needed. In-
ventor needs to calculate all lines for all 
views.  
3) Open a new drawing and select “Base 
View”.  

4) In the “Drawing View” dialog, select one 
design view, and your LOD should be high-
lighted.  
5) Select the “Right” orientation and hit OK.  
(HINT) One option “Raster View Only” is in 
“Drawing View” dialog, and the default is 
off. When it is checked, it only generate the 
raster view. For more details about raster 
view, please see the next section.  

 
6) Once the view is placed you should see 
an icon in the model tree that shows the 
view is being generated.  

 
7) Inventor 2014 will use all cores to pro-
cess views now.  
In the Application Options\Drawing Tab you 
have the option to enable background up-
dates on view creation. 
What this will do is allow you to work on the 
drawing while the lines are being drawn and 
each available processor core will be used 
to generate a view. A snapshot, called a 
raster image, of the desired view is shown 
while the lines are being drawn. This snap-
shot has some intelligence in that you can 
add dimensions and balloons while the view 
is being generated. 

 

8) To see this, open Windows Task Mana-
ger to view all cores.  

9) In the drawing, place several projected 
views bounding boxes, right click and choo-
se “Create” then roast a marshmallow over 
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the cores!  

10) When the drawing views are finished, 
part list is added to document. View Repre-
sentations can be used as a filter for a 
BOM.  
11) If the BOM is filtered to use a specific 
View Representation, only the parts that are 
visible will show up. The only downfall to 
this is that the quantity shown in a filtered 
BOM shows the total quantity and not the 
actual amount displayed in the view. To ac-
cess the BOM filters, right click on the BOM 
and select “Edit Parts List”.  
12) In the Parts List, select the “Filter Set-
tings” icon. 

 
13) In the Filter Settings dialog, follow the 

settings below. 
14)  
(HINT) You can use more than one filter for 
more control over what information is 
shown in the BOM against what is shown in 
the drawing view. Try setting the filter for 
“Purchased” and then add your View Re-
presentation. To remove a filter either un-
check it or use the delete key.   Filters are 
applied to the BOM in the order listed. 

 
 

4.4.2 Raster view 

Inventor 2014 supports to only create raster view, which will help users quick generate the drawing view 
without precise calculation, although the assembly is large. For raster view, most of annotations can be 
added, but the quality of raster views is not good for printing or zooming in/out. So the raster views are 

required to be converted to precise view when it is used for production.  
 

1) For the new design, raster view can be quick-
ly created, and add the annotations. When 
done, we convert it to precise view as the fi-
nal result. Maybe it will cost a long time for 
conversion, but we could make it done when 
the user is not busy.  

 
2) For the legacy design reused, firstly we need 

to convert the precise views, then update the 
3D design, finally convert the raster view to 
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precise view when the calculations of raster 
view updating are done. 

 
(HINT) In the Application Options\Drawing Tab 
you have the option to enable background up-
dates on view creation. 
What this will do is allow you to work on the 
drawing while the lines are being drawn and 
each available processor core will be used to 
generate a view.      

 

 
 

4.4.3 Drawing views composed for extremely large assembly 

For some customers, they use Inventor to design manufacture process line, and want to generate the 
drawing view based on the 3D model. But the top assembly is extremely large.  

 
1) As the top assembly is composed by several 

components, and these components are on 
one layout. If we use the top assembly to 
generate the drawing view directly, it will 
take a very long time to generate the draw-
ing view, sometime maybe the drawing view 
can’t be generated as the top assembly is 
too large.  

 
2) We need to consider generating the drawing 

view for every component. 

           
 

3) Compose these drawing views in one layout 
for the top assembly. 
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5 Best Practice: Typical LAM Workflow in Inventor 2014 

5.1 Bottom Up vs. Top Down Design  

Mechanical design is a highly creative and complex activity. Powerful computers form a basis for compe-
titive solutions, reduce product development time and provide means of communication within the de-
sign team. 
 
When we talked CAD design methodology, there are two typical design method will be mentioned, that 
is, Bottom Up and Top Down Design. 
 
Bottom Up is the traditional way of building assemblies. You first define the different parts. Then you put 
them into sub assemblies using assembly constraints. The sub assemblies are then placed into higher 
lever assemblies up to the top level assembly and in this way, you are working your way from the bottom 
up. This assembly method will create assemblies with a number lot of relationships between parts and 
assemblies. This approach can lead to two things:  

1. It can consume system resources and slows down performance.  

2. It can make models hard to change due to a lot of cross references and/or referenced geometry that 
gets deleted.  

 
A simplified example of this approach is the building of a house of cards. You start from the bottom 
leaning the cards towards each other for support and build your way upwards where every new card 
placed are dependent on the previously placed cards. If you then need to perform a design change like 
replacing one of the cards in the first layer with a new one you’ll run into stability problems since later 
placed cards are dependent on the card you remove.  
 
Skeletal, top down design is a method of working 
with large assemblies. Basically, you put all 
known factors into a skeleton file which is then 
used as a base for most of the sub assemblies 
and parts that make up the assembly.  
 
Top Down is a method where you start defining 
the end result and build in all of the known design 
criteria. This becomes the base for underlying 
sub assemblies and parts. In this way you will 
have a single conceptual file containing the over-
all information of the design with a single place 
for incorporating design changes.  

 
Working this way provides a much more stable Inventor model, faster updates, more available resources 
for handling larger data sets, an easier way of working in a collaborative environment and a better way 
of doing design work in general.  
 

Skeletal Design Methods  
There are four different methods that can be used for skeletal design:  

1. Skeleton File  

A skeleton file can contain any type of elements in any combination. Typical information created in a 
skeleton file may be:  

a. Sketches: used to define the concept of the final product or may be used as a layout of diffe-
rent areas of the assembly. 
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b. Work geometry: used to define important connection points, axial directions, and work planes 
that defin assembly levels. 

c. Parameters: define important values for part size, angles for placements, and other known 
values for the design. 

d. Solids: used to define volumes for final assembly as a single part or for defining sub-areas of 
the design. 

2. Master Sketch  

A master sketch can be used to control the form, fit, and function of a design. 

 

3. Absolute Origin  

This is a method where all sub assemblies are placed at the same origin. Every sub-assembly is ba-
sed on an origin part. This origin part is usually a sketch or a solid defining the volume. All sub-
assemblies are positioned against the origin parts 0,0,0 location and then grounded. 

 

4. Workspace Envelope Method 
This method uses defined workspace for individual assembly components and mutual contacts of the 
components. Boundary faces or placeholder solids define the workspace.Internal structure of indivi-
dual components (subassemblies) is created inside the workspace. Again, the procedure is tightly 
bound to component simplification method, as the placeholder solids may be used for parent as-
sembly composition. Practical use of this method corresponds to the master sketch method. 
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There is neither a universal procedure nor a general method. The essential aim of the design includes 
an easy-to-manufacture product, cost-effective production, and useful drawing documentation. Top 
Down and Bottom Up all have its applicability on specific design cases. In reality, it’s very common to 
and necessary to use combination of multiple methods to produce complex assemblies. 
 

5.2 LAM workflow process 

Autodesk Inventor provides rich functionality to support different design method here, and we will not de-
scribe more details of design method. From below image, we would like to show you a whole picture of 
LAM in your design process. 
 



Large Assembly Performance  

 

                                                                                                                                                                                Page 39 of 41 

 
 

General 
Assembly

Sub 
Assembly 3

Part

Part

Part

Part

Part

Part

Skeletal/Concept
To

p
 D

o
w

n
 

W
o

rk
fl

o
w

B
o

tt
o

m
 U

p
 

W
o

rk
fl

o
w

Sub 
Assembly 2

Sub 
Assembly 1

 

Skeletal Design Method (Top-Down) 

 Skeleton file 

 Master Sketch 

 Absolute Origin 

 Workspace Envelope 

 Please refer section 5.1 for these methods 
 

Assembly Level  

 Reduce number of components, please refer section 4.1.1 

 LOD, Shrinkwrap & Derive, please refer section 4.1.3 

 Express mode, please refer section 4.2 
 

Part level 

 Suppress unnecessary features, please refer section 4.1.2.1 
 BIM Simplification, please refer section 4.1.2.2 

Bottom-Up  

 Project settings, please refer section 3.1 

 Plan for Assembly Hierarchy Efficiency, please refer section 
3.3.3 
 

 
 

Drawing

 

Drawing 
 LOD & View Representation, please refer section 4.4.1 
 Raster view, please refer section 4.4.2 
 Drawing views composed, please refer section 4.4.3 
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6 Special Thanks 

This manual is a gathering of experience and knowledge on large assembly, and the main goal is to help 
our customer better use Autodesk Inventor product in their design and work. Here special thanks Andy 
Sears to provide the support and material for reference, and Inventor QA and development team for the 
offline support. 
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7 Useful Links 

 Dataset used in this document: http://a360.co/16JostY 

 Help Document: http://help.autodesk.com/view/INVNTOR/2014/ENU/?contextId=HELP_SYSTEM 

 News Group Forum: http://forums.autodesk.com/t5/Inventor/ct-p/70 

 Inventor IdeaStation: http://forums.autodesk.com/t5/Inventor-IdeaStation/idb-p/v1232 


